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1. INTRODUCTION
Thank you for choosing the SC-1 Leaf Porometer from METER Group. 

The SC-1 measures stomatal conductance, which is a function of the density, size, and 
degree of opening of plant pores. The SC-1 measures stomatal conductance by putting the 
conductance of a leaf in series with two known conductance elements and comparing the 
relative humidity (RH) measurements between them. This manual describes the functions of 
the SC-1 and how to make high-quality stomatal conductance measurements.

Verify all SC-1 Leaf Porometer components are included and appear in good condition:

• SC-1 sensor head (Section 3.2)

• SC-1 controller (Section 3.3)

• USB-to-serial cable

• USB drive with Leaf Porometer Utility (attached to manual cover)

• Calibration plate

• Bottle of deionized (DI) water

• Bottle of desiccant  
(Drierite® indicating desiccant, 10-20 mesh)

• Dispensing cap

• Tweezers

• Leaf pads

• Bead retention screens

• Teflon filters

• Calibration filter papers  
(Whatman® filter paper, grade #3)

• Spare hinge pin

• Short hinge pin

• White fluoropolymer agitation beads  
(McMaster-Carr® PTFE balls, 1/8 in, part #9660K13)

The SC-1 was shipped without batteries to preserve battery life and prevent damage to the 
instrument. Install four AA batteries in the SC-1 controller prior to use.
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2. OPERATION
Please read all instructions before operating the SC-1 Leaf Porometer to ensure it performs 
to its full potential. 

PRECAUTIONS
METER instruments are built to the highest standards, but misuse or neglect may damage 
the device and possibly void the manufacturer’s warranty. Before using the SC-1, follow the 
recommended user instructions and arrange proper protections to safeguard the instrument 
from damage.

2.1 CONFIGURING
Before taking measurements, configure the SC-1 system date, time, and units to ensure 
accurate timestamps and measurements readings. The date and time can also be changed 
using the Leaf Porometer Utility (Section 3.4). The units can be changed at any time on the 
Measurement tabs (Section 3.3.1).

Use the following steps to configure the SC-1 controller prior to readings.

1. Turn on the SC-1 controller.

2. Press MENU to navigate to the Configuration tab (Figure 1).

Figure 1 Configuration tab

3. Use UP and DOWN to highlight Date.

4. Press ENTER.

The system date appears in the center of the screen in a day/month/year format 
(Figure 2). Arrows appear above and below the first value, indicating the value can be 
edited.
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Figure 2 Select current date on the Date screen

5. Use UP and DOWN to change the first number. Holding down the arrow buttons will scroll 
quickly between values.

6. Press ENTER to move to the next value or ESC to return to the previous value. Repeat 
step 5 until the correct date is selected.

7. After the last value is changed, press ENTER to return to the Configuration tab.

8. Use DOWN to highlight Time.

9. Press ENTER.

The system time appears in the center of the screen, in 24-h format (Figure 3). Arrows 
appear above and below the first value.

Figure 3 Select current time on the Time screen

10. Use UP and DOWN to change the value.

11. Press ENTER to move to the next value or ESC to return to the previous value. Repeat 
step 10 to select the accurate time.

12. After the last number is changed, press ENTER to return to the Configuration tab.

13. Use DOWN to highlight Units.

14. Press ENTER to scroll through the options.
NOTE: The SC-1 default is millimoles per meters squared seconds (mmol/[m2s].)

The units can also be changed at any time on the Measurement tab.

15. Press MENU to return to the Measurement tab.
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2.2 TAKING A MEASUREMENT
Before using the SC-1, install the batteries (Section 4.2.1) and set the date and time 
(Section 2.1). Review factors that may affect measurements (Section 2.2.1) and follow the 
measurement process closely (Section 2.2.2).

2.2.1 MEASUREMENT CONSIDERATIONS
Leaf stomatal conductance depends on the amount of shade and sunlight the leaf receives, 
its age, and its position on the plant. To obtain a plant stomatal conductance average, take 
a variety of readings from different positions on the plant. The average will be proportional 
to the type of readings taken. For example, if the plant receives 70% sunlight, take seven 
readings from the sunny part and three from the shady part. Do not make repeated 
measurements on the same spot on a single leaf.

NOTE: Prolonged exposure (>2 min) to low RH conditions induces stomatal closure in most plant species. The 
SC-1 Auto mode measures stomatal conductance in 30 s, so the presence of the desiccated leaf clip should not cause 
stomatal closure unless multiple measurements are made in quick succession on the same location of the same leaf.

Average readings can also be taken for a field of plants. For example, readings from a leaf on 
the same place of each stalk of corn in a field would give an average for that field.

While taking measurements or storing the sensor, avoid chemical fumes (e.g., alcohol, 
gasoline, or volatile organics). Fumes can be extremely harmful to the sensor (Section 4.3).

The following factors will affect measurements taken by the SC-1:
• Light: Stomatal conductance readings vary in different lights. Readings taken on overcast 

days, in shadow, or in shade generally have lower conductances than those taken in 
greater light. 

• Temperature: Temperature also affects stomatal conductance readings. For most plants, 
extreme temperatures (very hot or very cold) will cause photosynthesis to slow down or 
stop and the stomata will narrow or close.

• Relative Humidity: RH at the leaf surface will affect readings. Stomata open more widely as 
RH increases. 

• Carbon Dioxide: An increase in carbon dioxide (CO2 ) causes the stomata to close, while a 
decrease causes them to open. Exhaling CO2 directly onto the plant will adversely affect 
readings, particularly in growth chambers or greenhouses.

Additionally, METER recommends always using desiccant to take readings. If operators wish 
to make readings without desiccant, METER recommends doing so at an ambient RH of 
<30%. Follow these exceptions when measuring without desiccant:
• Remove the desiccant chamber from the sensor head and do not cover the hole in the 

sensor head. Keep fingers away from the diffusion path when taking measurements.

• Recalibrate the sensor without desiccant (Section 4.1).

• Allow equilibration between measurements at ambient RH by opening the clip and shaking 
the sensor head to mix the air in the diffusion path. 
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• Discard the first reading in Auto mode. This first reading always reads low. Begin recording 
data with the second measurement.

NOTE: This is not an issue while using the desiccant chamber.

2.2.2 MEASUREMENT PROCESS
Prior to taking a measurement, perform the following tasks for best results.

1. Confirm the weather will be clear of precipitation and wait for dew or other water to 
evaporate.

2. Ensure sensor head is clean and free of dirt and pollen (Section 4.2.2). Use a dry swab 
to clear out debris from the sensor head instead of blowing on it, which can affect the 
stomatal conductance reading.

3. Firmly connect the sensor head cable to the SC-1 controller.

4. Equilibrate the sensor head to ambient temperature.

This may take 10 min or longer if the temperature of the SC-1 is very different from 
the sampling environment (e.g., from a cool air-conditioned room to a hot outdoor 
environment). Thermal disequilibrium will cause inaccurate measurements.

Holding the sensor head in the correct manner during the measurement is very 
important for maintaining thermal equilibrium. Figure 4 illustrates the correct way to 
hold the sensor head.

Figure 4 Correct way to hold the sensor head

Also prior to taking measurements, add desiccant to the desiccant chamber using the 
following steps. METER recommends fresh desiccant be used for each day of measurement.

NOTE: Early versions of the SC-1 sensor block do not have the desiccant chamber because the discontinued sensors 
in those models did not require it. However, current sensors require the use of the desiccant chamber for best results.

1. Unscrew the black detachable dessicant chamber from the bottom of the aluminum 
sensor block (Figure 5). 
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Figure 5 Filling desiccant chamber

2. Fill the chamber with Drierite Indicating Desiccant approximately 3/4 full.

3. Screw the desiccant chamber back to the sensor head. Ensure the chamber is screwed 
in far enough to compress the o-ring on the desiccant chamber and create a good 
vapor seal. 

Use the following steps to take a measurement:

1. Turn the SC-1 controller on.

2. Press MENU to navigate to the Configuration tab (Figure 6).

Figure 6 Toggle between Auto and Manual modes

3. Use the UP and DOWN arrows to navigate to Mode (Figure 6). 

4. Press ENTER to select Auto.
NOTE: See Section 3.3.2 for explanations of Auto and Manual modes.

5. Press MENU to return to the Measurement tab (Figure 7).
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Figure 7 Measurement tab before beginning a reading

6. Press ENTER to begin a reading.

The SC-1 will check the initial conductance and the absolute values of the RH sensors 
prior to beginning a reading. It is common to need to equilibrate the sensor due to one of 
these issues. The status bar on the right shows progress toward equilibration as a black 
bar dropping toward the EQU pointer.

If a warning appears that Initial conductance is too high (Figure 8), equilibrate the 
humidity in the sensor head by closing the leaf clip and allowing the desiccant to dry 
the air in the measurement path. Hold the sensor in a vertical orientation and shake the 
sensor head briskly side to side to accelerate the process. Generally speaking, the faster 
the shake, the faster the sensor head equilibrates. The bead will bounce between the 
screen and the Teflon filter, effectively mixing the air in the measurement path.
NOTE: The presence of the bead does not affect the stomatal conductance measurement as long as the bead 
does not move during the measurement. Keep the leaf clip oriented with the black desiccant chamber down 
during measurements. Do not invert the leaf clip during a measurement or the bead will rest on the screen and 
distort the diffusion of water vapor from the leaf through the diffusion path.

Figure 8 Warning screen for high initial conductance

Once the humidity in the measurement chamber has equilibrated, the porometer checks 
the absolute value of the RH sensors. If either sensor is above 10% RH, a second warning 
screen will appear indicating High RH Reading (Figure 9). Shake the sensor head to help 
the desiccant scrub the remaining water vapor from the measurement chamber.
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Figure 9 Warning screen for high RH reading

The total shake down period should be approximately 50 s. If it takes longer than 75 s to 
equilibrate, the SC-1 may have a problem. Refer to Section 4.3.

7. Once the measurement chamber has dried and equilibrated, the Measurement tab will 
display a prompt to insert the leaf (Figure 10).

Figure 10 Prompt to place sensor head on the leaf

8. Choose to measure adaxial (the top of the leaf) or abaxial (the bottom of the leaf) 
conductance, depending on plant type and desired data.

9. Orient the leaf appropriately for the measurement. The dessicant chamber must always 
be oriented down (Figure 11).

ABAXIAL (BOTTOM) ADAXIAL (TOP)

Figure 11 Leaf orientation during adaxial or abaxial conductance measurements
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10. Squeeze the leaf clip, quickly slide the leaf inside, and allow it to close gently.
NOTE: It is critical to slip the leaf clip onto a leaf within 5 s of opening the clip or unacceptable errors may be 
introduced into the conductance measurement.

The sensor head must remain still during measurement.

When measuring small needles or leaves, insert them into the sensor as shown in 
Figure 12. Multiple needles or small leaves (including blades of grass) may be needed to 
adequately cover the sensor aperture for an accurate measurement. It may be necessary 
to remove the leaves or needles from the plant to arrange them over the opening in the 
diffusion path. Complete readings of removed leaves within 2 min of removal (prior to 
stomatal closure) for an accurate measurement.
NOTE: The SC-1 may not be appropriate for all needle types. Highly sclerified, angular needles will prevent a 
good seal over the diffusion path and the reading will be compromised.

Figure 12 Measuring small leaves

The reading will begin once the leaf clip has been opened and closed. A progress bar 
will indicate the reading is underway, and a countdown timer in the top right will appear 
(Figure 13).

Figure 13 Measurement tab during reading 

11. Once the measurement is complete, remove the leaf clip from the leaf and close it to 
start equilibration for the next measurement.

12. Choose to save, annotate, or discard the data (Section 2.3).
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The SC-1 can measure the stomatal conductance beyond its recommended range of 0 to 
500 mmol/(m2s). Between 500 mmol/(m2s) and 6,000 mmol/(m2s), a ≈ symbol appears to 
the left of the reading. If the stomatal conductance reaches a value greater than or equal to 
6,000 mmol/(m2s), an ∞ symbol appears in place of the measurement.

2.3 SAVING DATA
In Auto mode, the option to save data appears as soon as the timer has expired. In Manual 
mode, data can be saved at any time during the reading. These steps explain how to save 
data in either mode.

1. In Auto mode, the Select Method screen appears at the completion of the measurement 
(Figure 14). 

In Manual mode, press ENTER at any time to access the Select Method screen.

Figure 14 Choose to save, annotate, or discard data

2. Use UP and DOWN to move the radio button selection to Save, Annotate, or Discard.

a. Save will save the reading as-is.

b. Discard will not save the reading and will return to the Measurement tab.

c. Annotate will bring up the Annotate screen to give the data a file name (Figure 15).

Figure 15 Annotate screen

3. Use UP and DOWN to change the character of each space (A-Z, 0-9, or special characters 
., -,‘, #, or space). Holding down the arrow buttons will scroll quickly between values.

4. Press ENTER to move to the next character. Repeat until the last character, pressing 
ENTER to reach the end of the row.
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2.4 VIEWING DATA
To view prior test results, use the following steps:

1. Press MENU to navigate to the Data tab (Figure 16). 

Figure 16 Data tab

2. Press ENTER to select View.

3. Scroll through the list of saved tests using UP and DOWN (Figure 17).

Figure 17 View data screen

Each entry shows the time acquired, stomatal conductance or resistance value (in the 
unit set as the default), and its annotation (if saved with one). Data must be downloaded 
to see more detailed information (Section 2.5)

4. Press ESC to return to the Data tab.

2.5 DOWNLOADING DATA
METER recommends using the Leaf Porometer Utility (Section 3.4) to download data. 
This function transfers all saved measurement data on the SC-1 to a computer. Follow 
steps 1 through 9 to download data.

NOTE: Leaf Porometer Utility is compatible with Microsoft® Windows® 98 and newer. See Section 3.4 for more details.

1. Connect the serial end of the USB-to-serial cable to the SC-1 controller.

2. Connect the USB end of the cable to an available USB port on the computer.



12

OPERATION

3. Open Leaf Porometer Utility (Figure 18).

Figure 18 Leaf Porometer Utility application

4. Choose the appropriate communication port from the from the Use computer 
communication port dropdown on the main window (Figure 19).

Figure 19 Leaf Porometer Utility main window

5. Click Download.

The Save Leaf Porometer Data window appears (Figure 20).

Figure 20 Choose file name and location on the Save Leaf Porometer Data window

6. Name the data file.



13

SC-1

7. Select the location and the format of the file. 

The file can be saved as one of the following:

 � Microsoft Excel® Workbook (*.xls)

 � Text (tab delimited) (*.txt)

 � CSV (comma delimited) (*.csv)

 � Raw data (comma delimited) (*.txt)

8. Click Save to download. 

A progress bar shows the status of the download process (Figure 21).

Figure 21 Download status

Press Cancel to cancel the download at any time. The software will not save any 
downloaded data.

9. Navigate to the saved file location and open the file to view the data.

Data are organized in the same way regardless of format. The measurement record will be 
divided into eight columns:
• Measurement time

• Stomatal conductance or resistance

• Temperature (in degrees Celsius or Fahrenheit)

• Sample ID (if saved with measurement)

• Sensor head serial number

• Calibration number

• Leaf Sensor %RH

• Filter Sensor %RH
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In all file types, scan records (saved from the Diagnostics screen) are interleaved with the 
normal data records and can be identified by the annotation Scan. Scan records have four 
additional columns:
• Leaf Sensor RH (in percent RH)

• Leaf Sensor Temperature (in degrees Celsius or Fahrenheit)

• Filter Sensor RH (in percent RH)

• Filter Sensor Temperature (in degrees Celsius or Fahrenheit)

Data can also be downloaded through the SC-1 controller or a terminal program, if the 
Leaf Porometer Utility is not functioning properly. Contact Customer Support for more 
information.

2.6 ERASING DATA
Data can be erased using the SC-1 controller or the Leaf Porometer Utility.

Data cannot be erased one measurement at a time. This feature erases all data from the 
SC-1 permanently and it cannot be recovered!

To erase all stored data from SC-1 using the SC-1 controller:

1. Press MENU to navigate to the Data tab.

2. Use UP or DOWN to highlight Erase.

3. Press ENTER.

The following warning will appear (Figure 22).

Figure 22 Warning confirming to erase all stored data

4. To return to the Data tab and leave stored data intact, press ESC.

To erase data from memory, press ENTER. Erasing... will be displayed as data is being 
removed, which usually takes about 6 s.

WARNING: This will delete all data permanently.

When the process is complete, the Data menu will reappear.
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To erase all stored data using the Leaf Porometer Utility (Section 3.4) :

1. Connect the serial end of the USB-to-serial cable to the SC-1 controller.

2. Connect the USB end of the cable to an available USB port on the computer.

3. Open Leaf Porometer Utility (Figure 23).

Figure 23 Leaf Porometer Utility main window

4. Choose the appropriate communication port from the Use computer communication 
port dropdown on the main screen.

5. Click Erase (Figure 23).

6. Click OK (Figure 24).

WARNING: This will delete all data on the SC-1 permanently.

Figure 24 Erase data confirmation dialog

7. A progress bar shows the status of the erase process.
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3. SySTEM
This section describes the SC-1 Leaf Porometer components and theory.

3.1 SPECIFICATIONS
MEASUREMENT SPECIFICATIONS

Stomatal Conductance

Range 0 to 1,000 mmol/(m2s)

Resolution 0.1 mmol/(m2s)

Accuracy ±10% of measurement from 0 to 500 mmol/(m2s)

NOTE: The SC-1 can measure higher than 500 mmol/(m2s) and detect relative stomatal conductance change in 
the high range, but absolute accuracy becomes unverifiable past 500 mmol/(m2s).

Measurement Time

30 s

PHySICAL SPECIFICATIONS
Controller Dimensions

Length 15.8 cm (6.2 in)

Width 9.5 cm (3.8 in)

Height 3.3 cm (1.3 in)

Sensor Head Dimensions

Length 12.0 cm (4.7 in)

Width 2.5 cm (1.0 in)

Height 5.5 cm (2.2 in)

Sensor Aperture Diameter

6.35 mm (0.25 in)

Sensor Cable Length

1.2 m (4 ft)
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Operating Temperature Range

Minimum 5 °C

Maximum 40 °C

Operating Relative Humidity Range

Minimum 1%

Maximum 100%, with desiccant chamber

Power

4 AA batteries

Battery Life

2 years (battery drain in sleep mode is <50 μA)

Data Storage

4,095 measurements in flash memory

Connector Type

Serial-to-USB

COMPLIANCE
Manufactured under ISO 9001:2015

EM ISO/IEC 17050:2010 (CE Mark)

3.2 SC-1 SENSOR HEAD
This SC-1 sensor head gathers the measurements (vapor pressure, RH, etc.) that the 
SC-1 uses to calculate stomatal conductance in a leaf. Figure 25 shows the external 
components of the sensor head and Figure 26 shows the internal components.
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Figure 25 Sensor head external components

Figure 26 Sensor head internal components

The cable and the sensor head electronics are connected and the cable and cable strain 
relief are not designed to be disconnected from the sensor head. Keep the strain relief 
screwed into the sensor head firmly. 

The SC-1 relies on a measurement of the RH gradient between the leaf evaporating surface 
and the desiccant chamber. The use of the desiccant chamber lowers the ambient RH to near 
0%, thus ensuring a steep RH gradient between the leaf and desiccant chamber. Although 
several different desiccants may work in the SC-1 (e.g., silica gel and molecular sieve), 
METER recommends Drierite 10-20 mesh because it has the best combination of sorption 
rate and total water sorption properties for this application.

NOTE: For the Drierite Indicating Desiccant safety data sheet (SDS), a printable version is available at metergroup.
com/environment/meter-safety-data-sheets.

https://www.metergroup.com/environment/meter-safety-data-sheets/
https://www.metergroup.com/environment/meter-safety-data-sheets/
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3.3 SC-1 CONTROLLER
The SC-1 controller is the menu-driven handheld interface with the sensor head (Figure 27). 
The controller requires four AA batteries to operate and has a serial connection to connect to 
the sensor head or computer. 

SC-1 Leaf Porometer

Figure 27 SC-1 controller

The SC-1 controller has six buttons. The POWER button turns the controller on and off. 
Pressing MENU switches between the Measurement, Data, and Configuration tabs. Pressing 
ENTER selects an option or begins a measurement. The two arrow keys (UP and DOWN) 
navigate within menus, and ESC backs out of menus or cancels actions.

3.3.1 TABS
The SC-1 controller features three main menus: Measurement, Data, and Configuration.

MEASUREMENT TAB
The Measurement tab is the default screen (Figure 28). The top number is the stomatal 
conductance number and the currently selected unit of measurement. Below are two 
columns, the left for the top RH sensor (closest to the leaf) and the right for the bottom RH 
sensor (closest to the desiccant chamber). Each column has the temperature and percent 
RH of that sensor. The SC-1 uses these to calculate the stomatal conductance value 
(Section 3.5).
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Using UP or DOWN will change the units of the stomatal conductance measurement. 
Pressing ENTER will initiate a reading (Section 2.2).

Figure 28 Measurement tab

DATA TAB
This menu is to view, download, or erase data (Figure 29).
• View: Select to see reading time, measurement, and annotation (Section 2.4).

• Download: Select to send data to computer (Section 2.5)

• Erase: Select to delete data from controller memory (Section 2.6).

Figure 29 Data tab

CONFIGURATION TAB
This menu is used to alter system settings (such as the current time, date, and operating 
mode), select the appropriate units for readings, and view information about the 
SC-1 (Figure 30). There is also a battery icon on the right, indicating remaining battery power. 
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Figure 30 Configuration tab options

This menu features seven options:
• Calibration

The Calibration screen gives a menu of four items related to calibration (Figure 31). The first 
option, Calibrate, initiates the calibration process (Section 4.1).

Figure 31 Calibration screen

This menu can also be used to change the sensor serial number, manually input a 
calibration number, or restore factory defaults.

• Date

The date must be changed prior to use to record accurate information (Section 2.1). The 
format can also be changed in the Leaf Porometer Utility.

• Time

The time must be changed prior to use to record accurate information (Section 2.1).

• Mode

Mode can be in either Auto or Manual mode (Section 3.3.2). The mode must be set prior to 
beginning a measurement.

• Units

Data in the SC-1 can be displayed in three units: millimoles per meter squared seconds 
(mmol/[m2s], the system default), meters squared seconds per mole (m2s/mol), or seconds 
per meter (s/m).
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• Contrast

The Contrast screen controls the screen contrast. Press the DOWN arrow to scroll to it and 
press ENTER (Figure 32).

Figure 32 Contrast screen

Use the arrow keys to alter the contrast level. Press ENTER to save or ESC to cancel 
adjustments.

• Diagnostics

The Diagnostics screen displays real-time sensor values from the sensor head. An error 
message will pop up next to a reading if the value is out of range (Figure 33). Pressing 
ENTER during this screen will save a scan record that can be viewed or downloaded at a 
later time.

Figure 33 Diagnostics screen

• About

The About screen displays SC-1 serial number and firmware version (Figure 34).
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Figure 34 About screen

3.3.2 MODES
The measurement can be taken in two modes: Auto or Manual. For typical measurements on 
plant leaves, Auto mode is strongly recommended.

Auto mode makes an accurate stomatal conductance measurement in 30 s. To do this, the 
SC-1 takes the first 30 s of stomatal conductance data and applies a look-ahead algorithm 
to predict the final stomatal conductance reading if unlimited time were allowed for true 
steady state conditions to occur. The 30-s measurement duration ensures that stomatal 
conductance does not change due to the presence of the sensor head. Auto mode also sets a 
definite endpoint for the measurement and data can only be saved after that point. 

Manual mode measures stomatal conductance continuously and directly from the RH 
gradient between the two RH sensors (Section 3.5). The real-time conductance measurement 
can be saved at any time during a Manual mode measurement. Manual mode assumes that 
a steady state is reached, and the user must determine at what point the readings have 
stabilised enough to consider the measurement complete. Some common uses for Manual 
mode are measuring dark conductance in plants and measuring conductance of static 
conductance materials (e.g., fruit peels, waterproof fabric).  

NOTE: Manual mode should only be used at low conductances (i.e., <100 mmol/[m2s]).

In Manual mode, there is no time limit for taking readings, and the elapsed time is displayed 
directly below the system time (Figure 35).

Figure 35 Measurement tab in Manual mode
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3.4 LEAF POROMETER UTILITy
The Leaf Porometer Utility is a program designed specifically for interfacing with the SC-1. 
Use this program to download measurement data to a computer, erase the SC-1 data, set the 
date and time, and see information about the SC-1. 

The following minimum system requirements must be met to use the Leaf Porometer Utility:
• Microsoft Windows 98 or NT 4 (SP 5) or better

• Intel® Pentium® Pro or newer processor

• One available serial or USB port

• Microsoft Excel 97 or better (for viewing data as .xls files)

Install the Leaf Porometer Utility using the included USB flash drive (inside the cover of the 
SC-1 Manual). The latest version of the Leaf Porometer Utility can also be installed from 
metergroup.com/sc1-support.

1. Insert the USB into the USB port.

2. Open the USB drive named METER Group Inc. USA.

3. Move the Leaf Porometer Utility application onto the computer’s hard drive.

The four menus across the top of the screen change program and SC-1 settings. Below is a 
brief overview of the options each menu contains.

FILE MENU

• Download Data: Saves measurement data stored in the SC-1 as a data file on the computer 
(Section 2.5).

• Erase Data: Erases all data in SC-1 (Section 2.6).

• Exit: Quits the program.

EDIT MENU

• Cut, Copy, Paste, and Select All: Nonfunctional menu options

• Preferences: Opens the Preferences window.

The Preferences window has three tabs: Data File, Communications, and Application tabs 
(Figure 36).

https://www.metergroup.com/sc1-support
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Figure 36 Data tab in the Leaf Porometer Utility Preferences window

The Data File tab is used to change measurement units, column headers, and the date/time 
format (Figure 36).
• Porometer measurement units selections are Use Leaf Porometer Settings (save 

downloaded measurement data in the units used on the SC-1), mmol/m2s, m2s/mol, or s/m. 

Temperature units can be saved in Celsius (°C) or Fahrenheit (°F).

• Column headers checkbox includes column headers for saved data files (Section 2.5). This 
feature is on by default.

• Date/Time Format sets how the date and time are displayed in saved data files. By default, 
the program will use Windows Regional and Language Options (the system settings 
accessible in the Windows Control Panel).

The Communications tab is to change settings in communicating with the SC-1 (Figure 37). 
These should only need to be changed if troubleshooting a connection issue.

• Command Retries: Set the number of times the computer should automatically try sending 
communications commands (up to 10).

• Maximum Baud Rate: Set the maximum baud rate for talking to the SC-1.

• Force Find All Communication Ports: Select checkbox to detect all communication ports on 
the computer.
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Figure 37 Communications tab in the Leaf Porometer Utility Preferences window

The Application tab sets application preferences (Figure 38).
• Automatic Internet Version Check: Select to automatically check for updates for the Leaf 

Porometer Utility when connected to the internet. Updates can be manually searched for in 
the Help menu.

• Automatic Clock Synchronization: Sets the SC-1 controller time to the computer time 
automatically, when connected.

Figure 38 Applications tab in the Leaf Porometer Utility Preferences window
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ACTIONS MENU

• Set Porometer Date/Time: Synchronizes the SC-1 controller date and time to the computer 
date and time.

• View Porometer Information: Shows the serial number, firmware version, number of stored 
readings in the SC-1, firmware status, battery status, current date and time, and sensor 
calibration number (Figure 39).

Figure 39 Leaf Porometer Information screen

HELP MENU

• Help…: Accesses the Leaf Porometer Utility help file that provides detailed information on 
how to use the program.

• Send Feedback to Decagon: Provides the user with a way to submit feedback to METER.

• Check for Utility Updates: Checks for application updates.

• Check for Firmware Updates: Checks for firmware updates for the SC-1 controller.

• About Leaf Porometer Utility: Displays the current program version and METER contact 
information.

Occasionally, METER releases firmware updates for the SC-1 to improve the performance 
of the instrument. These updates can be found through the Leaf Porometer Utility Help 
Menu. Do not turn off or disconnect the instrument from the communication port while the 
firmware is updating.

WARNING: Any data records on the instrument will be erased during a firmware update. Download data before loading 
new firmware.
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If upgrading to the latest firmware, verify the SC-1 is equipped with a desiccant chamber. 
Porometers that predate the desiccant chamber should not be updated beyond firmware 
version 1.33. Contact Customer Support for more specific information on upgrading the 
sensor head.

To update the firmware, use the following steps:

1. Connect the SC-1 to an available communication port.

2. Download the SC-1 Firmware Updater executable file from the SC-1 product website 
(metergroup.com/sc1-support).

3. Click Run.

If the application does not automatically ask, open the firmware updater application 
from the Downloads menu.

A warning will appear to download all saved data (Figure 40).

Figure 40 Data Erase Warning dialog

4. Click OK.

The Leaf Porometer Firmware Updater window should appear (Figure 41).

Figure 41 Leaf Porometer Firmware Updater

5. Select the correct communication port in the dropdown list.

6. Click Start.

7. When the firmware updater is finished, close the application.

https://www.metergroup.com/sc1-support
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3.5 THEORy
The SC-1 Leaf Porometer measures stomatal conductance of leaves. Stomata are small 
pores on the top and bottom of a leaf that are responsible for taking in and expelling CO2 and 
moisture. Stomatal conductance is the rate of passage of CO2 or water vapor through the 
stomata and is a function of the density, size, and degree of opening of stomata. 

The SC-1 measures this rate by putting a leaf in series with two known conductance 
elements and comparing the RH measurements between them. The RH difference across the 
known conductance elements gives the water vapor flux. The conductance of the leaf can be 
calculated from the known conductances and the RH gradient. The SC-1 diagram represents 
these measurement processes (Figure 42).

Figure 42 Diagram of SC-1 measurements

The parameters listed in Figure 42 represent the following:

Cleaf 
= mole fraction of vapor inside the leaf

C1 = mole fraction of vapor at node 1

C2 = mole fraction of vapor at node 2

gs = stomatal conductance of the leaf surface

gd1 = vapor conductance of the diffusion path between leaf surface and node 1

gd2 = vapor conductance of the diffusion path between node 1 and node 2

d1 = distance between the leaf surface and the first RH sensor

d2 = distance between the two RH sensors
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For the SC-1, the two distances are d1 = 3.35 mm and d2 = 11.43 mm.

The stomatal conductance ( gs ) is the variable the SC-1 ultimately measures. The derivation 
below shows how the variables above yield stomatal conductance. 

First, the vapor flux (Fvapor ) along the diffusion path will be determined using the RH 
difference between nodes 1 and 2 as given in Equation 1.

Equation 1= −F g C C( )dvapor 2 1 2

C values are related to RH by Equation 2

Equation 2=C
h e T
P
( )

i
r s a

atm
where hr is RH, es(Ta ) is the saturated vapor pressure at air temperature, and Patm is 
atmospheric pressure. es(Ta ) is calculated by the Tetens formula with appropriate coefficients 
for water vapor:

Equation 3
es(Ta ) = 0.611exp

17.502T
T + 240.97

⎛
⎝⎜

⎞
⎠⎟

NOTE:  T must be in degrees Celsius.

Next, the value of gd2 (Equation 1) must be determined by Equation 4

Equation 4

ρ
=g
D
dd 2
vapor

2



where ρ  is the molar density of air (Equation 5) and Dvapor is the diffusivity of water vapor 
(Equation 6). 

Equation 5ρ! = 44.6
Pa
101.3

273.15
T

⎛
⎝⎜

⎞
⎠⎟

Equation 6
Dvapor (T ,Pa ) = Dref (273.15,101.3)

101.3
Pa

⎛

⎝⎜
⎞

⎠⎟
T

273.15
⎛
⎝⎜

⎞
⎠⎟

1.75

Both of these quantities are temperature and pressure dependent; however, when multiplied 
together as in Equation 4, some of this dependency drops out.

Next, solve for the numerator in Equation 4. If

Equation 7= × −D (273.15,101.3) 2.12 10 (m /s)ref
5 2

then

Equation 8ρ!Dvapor = 44.6( ) 2.12×10−5( ) T
273.15

⎛
⎝⎜

⎞
⎠⎟

0.75
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Using C (from Equation 2) and gd2 (from Equation 4) values, Equation 1 can be solved for 
the flux:

Equation 9
Fvapor =

ρ!Dvapor
d2

⎛

⎝
⎜
⎜

⎞

⎠
⎟
⎟
1
Patm

hr1es(Ta1)− hr2es(Ta2 )⎡⎣ ⎤⎦

Now that Fvapor has been solved, the stomatal conductance (gs ) can be determined. This 
requires some assumptions. First, the RH within the leaf tissue is assumed to be 1.0, so 
Equation 2 becomes

Equation 10
=C
e T
P
( )s a

atm
leaf

Second, all conductance values are assumed to be in series, so the flux is constant between 
any two nodes. Third, the temperature of the leaf is equal to the temperature of the first RH 
sensor (the sensor block head is aluminum to eliminate the temperature difference). 

These assumptions mean Equation 1 can be written for node 1 and the leaf node 
(Equation 11, Equation 12) and then set equal to Equation 9 (Equation 13).

Equation 11= −+F g C C( )s dvapor 1 leaf 1

Equation 12
Fvapor = gs+d1

1
Patm

⎛

⎝⎜
⎞

⎠⎟
es(Ta1)(1− hr )⎡⎣ ⎤⎦

Equation 13

gs+d1
Patm

es(Ta1)(1− hr )⎡⎣ ⎤⎦ =
1
Patm

ρ!D
d2

⎛

⎝
⎜

⎞

⎠
⎟ hr1es(Ta1)− hr2es(Ta2 )⎡⎣ ⎤⎦

Solving for gs+d1,

Equation 14
gs+d1 =

ρ!D
d2

⎛

⎝
⎜

⎞

⎠
⎟ hr1es(Ta1)− hr2es(Ta2 )⎡⎣ ⎤⎦

es(Ta1)(1− hr1)
Then solve for gs using the rule for series combination of conductance (Equation 15).

Equation 15
= −

+g g g
1 1 1

s s d d1 1

Hence,

Equation 16

1
gs

=
es(Ta1)(1− hr1)d2

ρ!D hr1es(Ta1)− hr2es(Ta2 )⎡⎣ ⎤⎦
−
d1
ρ!D
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so:

Equation 17

gs =
ρ!Dvapor

es(Ta1)(1− hr1)⎡⎣ ⎤⎦d2
hr1es(Ta1)− hr2es(Ta2 )

− d1

Therefore, gs is a function of the distances between RH sensors, temperature, and the two 
RH readings.

When the conductance is small, the humidities are nearly the same, and the denominator of 
the denominator of Equation 18 goes to 0, causing problems. Multiplying top and bottom by 
the denominator gives

Equation 18
gs =

ρ!Dvapor hr1es(Ta1)− hr2es(Ta2 )⎡⎣ ⎤⎦
es(Ta1)(1− hr1)⎡⎣ ⎤⎦d2 − hr1es(Ta1)− hr2es(Ta2 )⎡⎣ ⎤⎦d1

NOTE: The resulting gs is in units of mol/m2s. 

For this theory to accurately predict the stomatal conductance using the steady-state 
diffusion technique, true steady-state conditions must exist in the diffusion path. 
The amount of time necessary to reach steady-state conditions is proportional to the 
conductance. At conductances <20 mmol/(m2s), steady-state conditions are generally 
reached in <5 min. At higher conductances, steady-state conditions can take up to 30 min 
and can become inaccurate.
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4. SERVICE
This section contains calibration and recalibration information, calibration frequencies, 
cleaning and maintenance guidelines, troubleshooting guidelines, customer support contact 
information, and terms and conditions.

4.1 CALIBRATION
For the SC-1 to make accurate readings of stomatal conductance, the two RH sensors in 
the sensor head must behave in a very repeatable manner. The sensors occasionally change 
characteristics over time. While the endpoint RH measurement may still be accurate, the 
response time of the sensors can change subtly which creates inaccurate conductance 
measurements. The best way to ensure accurate conductance measurements is to verify 
the accuracy of the SC-1 before taking measurements (Section 4.1.1) and calibrate if 
necessary (Section 4.1.2). The SC-1 may also need recalibration if there are drastic changes 
to environmental conditions or if the sensor head is used on an alternate handheld.

4.1.1 VERIFICATION PROCESS
METER recommends verification before every day of use or for every different set of 
environmental conditions (e.g., >15 °C temperature change). Also verify the accuracy of the 
SC-1 after the desiccant chamber is installed or removed. 

Use the following steps to verify porometer performance.

1. Allow the sensor head, DI water, and calibration plate to come to thermal equilibrium 
with the measuring environment. 

For example, moving the SC-1 from an air-conditioned environment into field conditions 
can take 10 min or more to reach equilibrium. A calibration block or bottle of DI water 
that has been kept in a pants pocket or hand for extended periods of time will also need 
time to reach equilibrium.

Holding the sensor head in the correct manner during verification is very important 
for maintaining thermal equilibrium. Figure 43 illustrates the correct way to hold the 
external sensor.

Figure 43 Holding the sensor head
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To check for thermal equilibrium, initiate a measurement in Manual mode (Section 3.3.2) 
or navigate to the Diagnostic screen (Section 3.3.1) to monitor temperature readings 
until the temperature is changing <0.25 °C/min.

2. Remove the desiccant chamber from the bottom of the leaf clip by unscrewing it 
counterclockwise.

3. Check the desiccant color. 

4. If the desiccant is blue, replace the desiccant chamber on the sensor head and continue 
to step 5.

If the desiccant is purple, the desiccant is exhausted and must be replaced. 

a. Discard the exhausted desiccant.

b. Refill the desiccant chamber 3/4 full with fresh desiccant. 

c. Replace the desiccant chamber on the sensor head.

5. Turn on the SC-1 controller.

6. Use tweezers to remove a piece of filter paper from the plastic bag.
NOTE: Do not touch the filter paper. Skin oils will contaminate the disk, resulting in improper readings.

7. Add one drop of DI to the filter paper to saturate it.

8. Allow the water a couple moments to fully absorb into the filter.

9. Still holding the disk with the tweezers, quickly flick the wrist to remove any excess 
water.

The paper should glisten, but no water drops should be clinging to the disk. 

10. Lay the filter paper flat over the hole in the calibration plate on the side marked Filter 
Paper. Make sure the paper completely covers the hole but does not cave into or bubble 
out from it.

11. Turn the calibration plate over and carefully examine the hole to make sure that no 
meniscus of water is present in the hole.

If excess water is observed, remove the filter paper, dry the calibration plate, and repeat 
step 7 through 11.
NOTE: If the filter paper becomes too dry to adhere to the calibration plate, it will need to be wet again, and the 
calibration procedure will need to be restarted.

12. Make two or three consecutive measurements on the calibration plate.

The resulting values should be within ±10% of the conductance value of the calibration 
plate, between 216 to 264 mmol/(m2s). If the SC-1 does not return readings within this 
range, perfom a user-initiated calibration (step 5).
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4.1.2 CALIBRATION PROCESS
SC-1 with firmware revision 1.30 or greater have the calibration feature. A video tutorial of 
the calibration process is available on metergroup.com/environment/articles/quick-guide-
calibrating-sc-1-porometer. METER has a calibration service to perform maintenance and 
calibration on the SC-1. The calibration routine is the same as outlined in this section.

NOTE: For instructions on how to upgrade the SC-1 firmware to the latest version, see Section 3.4. 

Each sensor head has a default 7-digit calibration number on the sensor head cable tag 
and on the calibration certificate. This default calibration number will be applied to each 
measurement until a user-initiated calibration is performed. The new calibration number will 
be stored and applied to all subsequent measurements until another calibration is done or 
the calibration is reset to the default.

If verification (Section 4.1.1) indicates that the measurements are inaccurate, use the 
following steps to calibrate the SC-1.

1. Allow the SC-1 sensor head, DI water, and calibration plate to come to thermal 
equilibrium with the measuring environment. 

For example, moving the SC-1 from an air-conditioned environment into field conditions 
can take 10 min or more to reach equilibrium. A calibration block or bottle of DI water 
that has been kept in a pants pocket or hand for extended periods of time will also need 
time to reach equilibrium.

To check for thermal equilibrium, initiate a measurement in Manual mode (Section 3.3.2) 
or navigate to the Diagnostic screen (Section 3.3.1) to monitor temperature readings 
until they are steady.

Holding the sensor head in the correct manner during calibration is very important 
for maintaining thermal equilibrium. Figure 43 illustrates the correct way to hold the 
external sensor.

2. Remove the desiccant chamber from the bottom of the leaf clip by unscrewing it 
counterclockwise.

3. Check the desiccant color. 

4. If the desiccant is blue, replace the desiccant chamber on the sensor head and continue 
to step 5.

If the desiccant is purple, the desiccant is exhausted and must be replaced. 

a. Discard the exhausted desiccant.

b. Refill the desiccant chamber ¾ full with fresh desiccant. 

c. Replace the desiccant chamber on the sensor head.

d. Turn on the SC-1 controller.

5. Press MENU to navigate to the Configuration tab (Figure 44).

https://www.metergroup.com/environment/articles/quick-guide-calibrating-sc-1-porometer/
https://www.metergroup.com/environment/articles/quick-guide-calibrating-sc-1-porometer/
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Figure 44 Configuration tab

6. Press ENTER to select Calibration.

The Calibration screen will appear (Figure 45).

Figure 45 Calibration screen options

7. Press ENTER to select Calibrate...

A warning screen will appear (Figure 46).

Figure 46 Warning screen to wait for thermal equilibrium

8. Press ENTER.

9. Enter the sensor head serial number (found on the sensor head cable tag) by pressing 
the UP or DOWN keys and pressing ENTER after each digit (Figure 47).
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Figure 47 Enter sensor head serial number

The Stability Test screen will appear (Figure 48).

Figure 48 Stability Test screen

The RH sensors must give similar RH readings to reach accurate stomatal conductance 
measurements. Before beginning a calibration, the SC-1 checks agreement between the 
two sensors in the sensor head.

10. Shake the leaf clip briskly in a vertical orientation to mix the air in the diffusion path 
and wait for the sensors to come to equilibrium (the indicator bar will move closer to the 
0 line). 
NOTE: Do not open the clip. The water vapor in the ambient atmosphere will slow the equilibration process.

Once the sensor readings stabilize and are confirmed to be within 2% RH of each other, 
the calibration routine automatically advances to the Prepare Calibration Plate screen 
(Figure 49). If the sensors do not equilibrate to similar RH values, refer to Section 4.3.

Figure 49 Prepare Calibration Plate screen
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11. Use tweezers to remove a piece of filter paper from the plastic bag.
NOTE: Do not touch the filter paper. Skin oils will contaminate the disk, resulting in improper readings.

12. Add one drop of DI to the filter paper to saturate it.

13. Allow the water a couple moments to fully absorb into the filter.

14. Still holding the disk with the tweezers, quickly flick the wrist to remove any excess 
water.

The paper should glisten, but no water drops should be clinging to the disk. 

The wetness state of the filter paper is critical for an accurate calibration. The paper 
must be wet enough to provide a 100% RH surface. However, if the paper is too wet, free 
water will be pulled into the calibration plate hole by surface tension and will change the 
effective dimensions of the hole and its conductance.

15. Lay the filter paper flat over the hole in the calibration plate on the side marked Filter 
Paper. Make sure the paper completely covers the hole but does not cave into or bubble 
out from it.

The plastic calibration plate has a known conductance of 240 mmol/(m2s). It is critical 
that the filter paper be properly placed for this conductance value to be correct. 

16. Turn the calibration plate over and carefully examine the hole to make sure that no 
meniscus of water is present in the hole.

If excess water is observed, remove the filter paper, dry the calibration plate, and repeat 
step 12 through 16.
NOTE: If the filter paper becomes too dry to adhere to the calibration plate, it will need to be wet again and the 
calibration procedure will need to be restarted.

17. Press ENTER on the SC-1 controller.

The Attach Sensor Head screen will appear (Figure 50).

Figure 50 Attach Sensor Head screen

18. Slide the calibration plate into the sensor head, orienting the side of the plate marked 
Metal Block toward the aluminum block side of the sensor head (Figure 51). A seating 
click will occur when the plate is placed correctly. The lip on the calibration plate should 
be fully fitted into the top of measurement hole.
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Figure 51 Sensor head on calibration plate

19. Orient the sensor head with the desiccant cap facing downward. The sensor can be held 
in this orientation by hand, or the entire sensor head and calibration plate assembly can 
be set on top of the SC-1 controller with the desiccant cap hanging off the edge. 

Proper orientation ensures the agitation bead sits on the Teflon filter and does not 
interfere with the water vapor diffusion from the leaf to the two sensors. 
NOTE: The sensor head must remain still during the calibration. The stomatal conductance measurement 
relies on water vapor transfer from purely molecular diffusion and any air mixing from movement will cause a 

substantial loss of accuracy.

The SC-1 will automatically begin the first reading (Figure 52). 

Figure 52 Calibrating screen during calibration

Each calibration measurement will take 30 s. The progress bar at the bottom of the 
screen and the timer at the top right of the screen indicate the status of the calibration 
measurement. 

Once a reading is complete, a prompt to equilibrate sensors will appear (Figure 53).
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Figure 53 Equilibrate sensors

20. Remove the sensor head from the calibration plate and close the clip.

21. Shake the sensor head to speed up the equilibration process.

As the sensors come to equilibrium, the indicator bar should move closer to the EQU line.

Once the sensors have equilibrated, the Attach Sensor Head screen will automatically 
reappear.

22. Repeat steps 19 through 21.

The SC-1 will continue to take calibration measurements until three consecutive 
measurements are within 7.5% of each other. This ensures that the SC-1 measurements 
have stabilized. The calibration should end after performing three to five calibration 
measurements and will continue for a maximum of 10 measurements. If this does not 
happen, consult Section 4.3.

If the calibration is successful, the Calibration Complete screen will appear (Figure 54).

Figure 54 Calibration Complete screen

The new calibration number is automatically saved into the controller. The most recently 
saved calibration number will be applied to all subsequent measurements until a new 
calibration is completed or the factory default calibration is restored.

The SC-1 is ready to take measurements. 
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After a calibration, METER recommends verifying that a calibration was effective. 

1. Navigate to the Measurement tab.

2. Press ENTER to take a measurement on the calibration plate.
NOTE: If possible, do not wet the filter paper again for the verification readings. If wetting is necessary, disregard 
the first measurement taken.

3. Repeat two to three times.

The measured conductance should be close to 240 mmol/(m2s).

4.2 MAINTENANCE
The SC-1 may be returned to METER for maintenance in the following areas: system 
inspection, parts replacement, and instrument cleaning. Replacement parts can also be 
ordered from METER. Contact Customer Support for more information. 

The SC-1 should be kept clean with full batteries to ensure proper working condition. To 
further extend the life of the SC-1, allow the sensor head to equilibrate to the ambient 
temperature before using and do not use it in rain or on leaves covered with dew or water 
droplets.

4.2.1 INSTALL BATTERIES
Although the SC-1 has been designed to provide an excellent battery lifespan, the batteries 
will eventually require changing. A low-battery indicator will appear in the upper left corner 
of the screen.

1. Carefully turn over the SC-1 controller and locate the battery cover.

2. Place the thumb on the grooves and slide the cover off the controller.

3. Remove the old batteries.

4. Insert new ones, orienting them properly.

5. Replace the battery cover.

6. Update the time and date (Section 2.1).

4.2.2 CLEAN SENSOR HEAD
Clean the sensor head periodically to remove contamination that can build up during routine 
use. It may be helpful to disconnect the sensor head from the controller prior to cleaning.

Items in this section are included with the SC-1; please contact Customer Support to order 
missing or replacement parts. Follow steps 1 through 11 to clean minor contamination in the 
sensor head (Figure 55). 
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1. Remove the desiccant chamber (Figure 55).

Dry swab

Desiccant chamber

O-ring

Teflon filter

Bead
Diffusion path

Figure 55 Quick cleaning of the diffusion path

2. Use tweezers to remove the o-ring.

3. Use tweezers to remove the Teflon filter. The Teflon filter should be handled around the 
edges and kept free of dust and moisture.

4. Remove the agitation bead.

5. Clean the diffusion path with a dry swab (Figure 55).
NOTE: Do not use alcohol or other organic liquids to clean the diffusion path! Direct contact or chemical vapor 
exposure can cause damage to the sensors! 

Do not dislodge the bead retention screen with the swab. See Section 4.2.2 to replace 
the screen if it is displaced.

6. Replace the agitation bead.

7. Replace the Teflon filter. 

If the Teflon filter becomes damaged or is excessively dirty, discard and replace.

8. Replace the o-ring.

9. Fill the desiccant chamber with fresh desiccant.

10. Replace the desiccant chamber.

11. Recalibrate the sensor prior to taking new readings (Section 4.1).

The sensor block may become contaminated with sap and leaf exudates that can lead to 
inaccurate conductance measurements. This type of contamination often cannot be removed 
with a quick cleaning. Instead, follow steps 1 through 20 for a more thorough cleaning 
(Figure 56). A short video of this procedure is at metergroup.com/environment/articles/
sc1-leaf-porometer-repair/.

https://www.metergroup.com/environment/articles/sc1-leaf-porometer-repair/
https://www.metergroup.com/environment/articles/sc1-leaf-porometer-repair/
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1. Remove the desiccant chamber (Figure 56).

Desiccant chamber

O-ring

Teflon filter

Dry swab

Screen

Bead

Diffusion path

Leaf clip

Spring

Hinge pin

Figure 56 Thorough cleaning of the diffusion path

2. Use tweezers to remove the o-ring.

3. Use tweezers to remove the Teflon filter. The Teflon filter should be handled around the 
edges and kept free of dust and moisture.

4. Remove the agitation bead.

5. Use a spare hinge pin to push the leaf clip hinge pin out of its seating, and remove 
both pins.

6. Remove the top of the leaf clip.

7. Remove the screen, if necessary.

Use a thin implement to press the bead retention screen out of the aluminum sensor 
block. It is best to leave the screen in place during cleaning if at all possible.

8. Clean the diffusion path and the bead retention screen (if necessary) with DI water and a 
cotton swab or paper towel.
NOTE: Do not expose the RH sensors to solvent vapors. Also avoid scrubbing the aluminum sensor block 
with abrasive materials as they can remove the hydrophobic finish on the block and affect conductance 
measurements.

9. Allow the sensor head to dry completely.

10. Place the bead retention screen over the diffusion path hole, with the concave side up.
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11. Gently push the edges down into the diffusion path.

Ensure the bead retention screen is fully recessed in the diffusion path but completely 
above the first RH sensor port, so it does not interfere with the leaf or the diffusion of 
vapor into the upper RH sensor port.

12. Place the spring inside the leaf clip top and use the short hinge pin to hold it in place 
temporarily.

13. Align the leaf clip top and spring with the leaf clip bottom.

14. Insert the hinge pin into the hinge hole, pushing the short hinge pin out the opposite 
side. Ensure the hinge pin is flush with the sides of the leaf clip.

15. Replace the agitation bead.

16. Replace the Teflon filter. 

If the Teflon filter becomes damaged or is excessively dirty, discard and replace.

17. Replace the o-ring.

18. Fill the desiccant chamber with fresh desiccant.

19. Replace the desiccant chamber.

20. Recalibrate the sensor prior to taking new readings (Section 4.1).

4.2.3 REPLACE LEAF PADS
Leaf pads can fall off or become damaged. When the sensor head is cleaned, check the 
condition of the pads. They should make full contact with the leaf. A spare set of pads is 
included in the SC-1 kit. Contact Customer Support if more leaf pads are needed.

To replace a leaf pad, use the following steps.

1. Remove the old leaf pad from the leaf clip, using tweezers, if necessary.

2. Clean any residue, dirt, or soil particles from the sensor block with a slightly damp cloth.

3. Peel the adhesive paper off the back of the new leaf pad.

4. Carefully place the new leaf pad on the leaf clip and press firmly.

4.2.4 REFRESH DESICCANT
Exhausted Drierite desiccant can be refreshed and reused. However, refreshed Drierite does 
not absorb as much water and does not last as long in the SC-1 as new material.

To refresh the desiccant, bake the desiccant at 210 °C for 1 h.
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4.3 TROUBLESHOOTING
The SC-1 is a high-performance, low-maintenance instrument, designed to have few 
problems if used with care. Table 1 lists common problems and their solutions. If the problem 
is not listed or these solutions do not solve the issue, contact Customer Support.

Table 1 Troubleshooting the SC-1

Problem Possible Solutions

The SC-1 does not turn on
Check that the batteries are inserted correctly.

Replace the batteries.

Display is difficult to see

Adjust the contrast.

• Navigate to the Configuration tab.

• Scroll down to Contrast.

• Use the UP and DOWN to adjust screen contrast level.

Sensor Head Failure error

Verify the sensor head is securely connected to the serial port 
receptacle. Restart the reading. 

If this screen reappears, the cable or sensor may be faulty.

• Navigate to the Configuration tab.

• Select Diagnostics.

• Press ENTER to save a Scan record.

• Contact Customer Support with the Scan record results ready 
for review.

Low battery message
Check that the batteries are inserted correctly.

Replace the batteries.

Date and time were reset! 
message

This message may appear after changing the batteries or loading 
new firmware onto an instrument. 

Follow instructions in Section 2.1 to correct the date and time.

Error: Invalid Cal Num 
screen

Either perform a user-initiated calibration by following instructions 
in Section 4.1 or restore the default calibration by using these steps:

• Navigate to the Configuration tab

• Select Calibration.

• Select Restore Defaults.

• Press ENTER on the confirmation screen.

Missing bootstrap loader! 
error

The instrument cannot download new firmware updates. The 
instrument must be serviced by METER. Contact Customer Support.



46

SERVICE

Table 4 Troubleshooting the SC-1 (continued)

Problem Possible Solutions

Firmware is corrupted! 
error

The firmware was not loaded properly or an update is needed. 

Check metergroup.com/sc1-support if a new firmware version 
is available. 

NOTE: Saved data records will be lost when new firmware is installed. 
Download any data before reloading the new firmware.

If a newer firmware version is not available, contact 
Customer Support.

The USB-to-serial adapter 
is not showing as an option 
in the communication port 
dropdown

Check that the device driver is properly installed. 

Reinstall the METER driver by downloading it (software.metergroup.
com/drivers/METER_USB_Driver_Installer-8.0.exe) and running 
the installer.

NOTE: Ensure the appropriate device driver is installed for third-party USB-
to-serial adapter cables.

Downloading data stops 
in the middle with an 
error message saying the 
connection was lost

A noisy serial connection can disrupt the connection between the 
Leaf Porometer Utility and the SC-1. If this error happens regularly, 
change the Leaf Porometer Utility Communication preferences.

• Go to Edit > Preferences.

• Select the Communication tab.

• Decrease the Maximum Baud Rate value or increase the Command 
Retries value.

• Click Close.

Conductance readings are 
not what was expected

Verify porometer accuracy (Section 4.1.1)

Recalibrate the sensor head (Section 4.1.2).

Clean the sensor head (Section 4.2.2).

The Teflon filter also may be wet or dirty. Dry out or replace the filter. 

The RH sensors may require repairs. Contact Customer Support.

Too much drift error

Stable calibration readings were not achieved in 10 readings. Leave 
the sensor head at ambient conditions for a 15 min and try again. 

If this message continues to appear after two or three calibration 
attempts, contact Customer Support.

The SC-1 will not calibrate, 
even after multiple 
attempts

The SC-1 is not in thermal equilibrium. Leave the sensor head at 
ambient conditions for 15 min and try again.

Clean the diffusion path and replace the Teflon filter (Section 4.2.2).

The RH sensors may have been contaminated. Contact 
Customer Support.

Desiccant not detected 
error

This displays only if the calibration was conducted using desiccant 
and the internal sensors have now equilibrated to RH >10%. 

Ensure that desiccant is in place or replace with a fresh batch.

http://metergroup.com/sc1-support
http://www.software.metergroup.com/drivers/METER_USB_Driver_Installer-8.0.exe
http://www.software.metergroup.com/drivers/METER_USB_Driver_Installer-8.0.exe
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Table 4 Troubleshooting the SC-1 (continued)

Problem Possible Solutions

Desiccant exhausted or 
not present error

This displays when the internal sensors have equilibrated at >10% 
RH. METER recommends to always use the desiccant chamber, but 
most importantly when ambient RH is > 30%. Ensure that desiccant 
is in place or replace with a fresh batch if taking measurements 
with desiccant.

Press ENTER to proceed with measurements without desiccant.

Bead retention screen 
missing

Replace bead retention screen:

• Remove the top of the leaf clip.

• Place the bead retention screen over the diffusion path hole, with 
the concave side up.

• Gently push the edges into the diffusion path.

• Gently push the middle downward.

The screen should sit snugly at the top of the diffusion path.

If the screen continues to fall out, contact Customer Support.

Bead retention screen 
is protruding out of the 
diffusion path and touching 
the leaf pad

Reinstall bead retention screen:

• Place the bead retention screen in the calibration plate hole.

• Push snug with a finger.

• Use the calibration plate to seat the screen firmly in the 
sensor head. 

It is critical to recess the bead retention screen in the diffusion path. 
If the screen extends out of the diffusion path, it will cut the leaf and 
cause erroneously high conductance measurements.

Initial conductance is 
too high message persists
or 
Equilibration shake 
down period between 
measurements extends 
past 75 s.

Close the leaf clip and shake the sensor head briskly in a vertical 
orientation to equilibrate.

Replace the Teflon filter (Section 4.2.2).

An air leak may have developed, allowing high RH air to leak into the 
measurement chamber. 

• Check the integrity of the round rubber seal that caps the 
measurement chamber.  

• Test for leaks by placing fresh desiccant in the desiccant chamber 
and leaving the sensor head undisturbed for 2-3 days. If the 
desiccant turns pink, there is a leak. Contact Customer Support.

High RH reading error 
persists

Check the desiccant and replace, if needed.

The Teflon filter may be clogged. Replace the filter as described in 
Section 4.2.2.

If the problem persists, contact Customer Support.

An infinity symbol 
appears in the place of the 
measurement

The stomatal conductance measurement is greater than or equal 
to 6,000 mmol/(m2s). Most often, the excessively high values are 
caused by water on the leaf surface. Remove water from the leaf and 
repeat the measurement.
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4.4 CUSTOMER SUPPORT
NORTH AMERICA
Customer service representatives are available for questions, problems, or feedback Monday 
through Friday, 7:00 am to 5:00 pm Pacific time. 

Email: support.environment@metergroup.com 
sales.environment@metergroup.com

Phone: +1.509.332.5600

Fax: +1.509.332.5158

Website: metergroup.com

EUROPE
Customer service representatives are available for questions, problems, or feedback Monday 
through Friday, 8:00 to 17:00 Central European time. 

Email: support.europe@metergroup.com  
sales.europe@metergroup.com

Phone: +49 89 12 66 52 0

Fax: +49 89 12 66 52 20

Website: metergroup.de

If contacting METER by email, please include the following information: 

Name 
Address 
Phone

Email address 
Instrument serial number
Description of the problem

NOTE: For products purchased through a distributor, please contact the distributor directly for assistance.

4.5 TERMS AND CONDITIONS
By using METER instruments and documentation, you agree to abide by the METER Group, 
Inc. USA Terms and Conditions. Please refer to metergroup.com/terms-conditions for details.

mailto:support.environment%40metergroup.com?subject=
mailto:sales.environment%40metergroup.com?subject=
https://www.metergroup.com
mailto:support.environment%40metergroup.com?subject=
mailto:sales.environment%40metergroup.com?subject=
https://www.metergroup.com/de
http://www.metergroup.com/terms-conditions
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icon  20
installation  1, 4, 41, 45
life  1, 17, 45
type  17, 19

C

cable  1, 5, 16, 17, 18, 19
calibration

filter paper  1, 34, 38
number  35, 40
procedure  35–41
screen  21, 36
values  40
video tutorial  35

calibration plate  1, 34, 37, 38
carbon dioxide  4
cleaning

instructions  41–44
items needed  41
video tutorial  42

communication port  12, 15, 27
compliance  17
components

agitation bead  1, 7, 39
bead retention screen  1, 42, 43, 47
controller. See controller
desiccant chamber  5–6, 18, 33
hinge pin  1, 18, 43
leaf clip  18, 43
leaf pads  1, 18, 44
o-ring  18, 42, 43
RH sensor  18, 37, 46

sensor head. See sensor head
Teflon filter  1, 42, 43, 46

configuration
date  2–3, 4, 21
time  2–3, 4, 21
units  2, 3, 25

controller
buttons  19
modes  23
specifications  16
tabs  19–22

customer support  48

D

data
annotate  10
details  13–14, 25
download  11–14, 46
erase  14–15
file types  13
save  10
scan record  22, 45
storage  17
units  3, 21, 25
view  11

desiccant  1, 4, 5–6, 18, 34, 35, 44, 46

E

email address  48

F

fax number  48
firmware  22, 27–28

L

leaf orientation  8
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Leaf Porometer Utility
Actions menu  27
communications settings  25
compatibility  24–27
download data  11–14
Edit menu  24
erasing data  15
File menu  24
Help menu  27
Preferences window  24–26
USB  1, 24

light  4

M

maintenance  41–44
measurement

abaxial  8
accuracy  16, 33
adaxial  8
considerations  4–5
leaf orientation  8
multiple  4
preparation  4, 5–6
process  6–10
range  10
small leaves and needles  9
time  16

mode
Auto  4, 5, 6, 10, 21, 23
Manual  6, 10, 21, 23, 34, 35

P

phone number  48
precipitation  5, 41

R

relative humidity  1, 4, 7, 17

S

screens
About  22
Annotate  10
Attach Sensor Head  38
Calibration  21, 36
Calibration Complete  40
Configuration  20–23
Contrast  22, 45
Data  20
Date  21
Diagnostics  22, 34, 35, 45
Erase  14
Measurement  19–48
Prepare Calibration Plate  37
Select Method  10
Stability Test  37
thermal equilibrium warning  36
Time  21
View  11

sensor head
cleaning  5
description  1, 17–19
equilibrating  5, 7, 9, 33, 36, 37, 41
holding  5, 33
serial number  36
specifications  16

specifications
measurement specifications  16
physical  16–17

stomatal conductance
display  13, 19–20
environmental factors  4
measurement  1, 17
measurement range  10, 16
theory  29–32
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T

temperature  4, 17
terms and conditions  48
theory  29–33
troubleshooting  45–47

calibration  45, 46
date and time reset  45
firmware corrupt  46
firmware update  45
high initial conductance  7, 47
high RH  7–8, 47
sensor head failure  45

V

vapor flux  30–32
verification

frequency  33, 41
procedure  33
values  34, 41
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